2021 AMA Summer Academic Conference

August 4-6

Welcome!
Thank You to Our Sponsors!
<table>
<thead>
<tr>
<th>Day</th>
<th>Time</th>
<th>Event Description</th>
<th>Stage</th>
</tr>
</thead>
</table>
| Thursday, 29 July | 3pm   | **General**  
**Presenter Practice**  
Stage - Plenary Stage                                                                 |                              |
| Friday, 30 July   | 9am   | **General**  
**Presenter Practice**  
Stage - Plenary Stage                                                                 |                              |
| Wednesday, 4 August | 7:45am | **Workshop**  
**Speaker Set Up**  
Stage - SAGE Publishing Stage                                                 |                              |
|               | 7:45am | **Workshop**  
**Speaker Set Up**  
Stage - SIG Programming and Special Session Stage                                 |                              |
|               | 7:45am | **Workshop**  
**Speaker Set Up**  
Stage - EBSCO Stage                                                               |                              |
|               | 7:45am | **Workshop**  
**Speaker Set Up**  
Stage - Stage 4                                                                    |                              |
|               | 8am   | **Workshop : Teaching**  
**Conducting Engaging Synchronous Online Courses**  
Chair: Prof. Timothy Keiningham  
Prof. Timothy Keiningham (St. John’s University)                                    |                              |

**2021 AMA Summer Academic Conference 04 - 06 Aug 2021 All times in CDT**

Powered by Ex Ordo, your online conference platform.
## Workshop: Skills - Casual Inference

**8am**  
**Workshop:** Casual Inference  
*Stage - SIG Programming and Special Session Stage*  
Chaired by: Prof. Kathy Li

### Causal Inference

- Prof. Kathy Li (University of Texas)

## Workshop: Career - Making the Transition from Academia to Industry

**8am**  
**Workshop:** Making the Transition from Academia to Industry  
*Stage - EBSCO Stage*  
Chaired by: Mr. Isaac Dinner and Ms. Annie Wilson

### Making the Transition from Academia to Industry

- Mr. Isaac Dinner (Indeed), Ms. Annie Wilson (Vanguard)

## Workshop: Skills - Addressing Endogeneity Part 1

**8am**  
**Workshop:** Addressing Endogeneity Part 1  
*Stage - Stage 4*  
Chaired by: Prof. Peter Ebbes and Prof. Dominik Papies

### Addressing Endogeneity Part 1: Causality, endogeneity, and econometric approaches

- Prof. Dominik Papies (University of Tuebingen), Prof. Peter Ebbes (HEC Paris)

## Workshop: Speaker Set Up

**9:15am**  
**Workshop:** Speaker Set Up  
*Stage - SIG Programming and Special Session Stage*

**9:15am**  
**Workshop:** Speaker Set Up  
*Stage - EBSCO Stage*

**9:15am**  
**Workshop:** Speaker Set Up  
*Stage - Stage 4*

**9:15am**  
**Workshop:** Speaker Set Up  
*Stage - Stage 5*

**9:15am**  
**Workshop:** Speaker Set Up  
*Stage - Stage 6*

**9:30am**  
**General**  
**JOURNAL OF INTERNATIONAL MARKETING AWARDS SESSION | S. Tamer Cavusgil Award and Hans B. Thorelli Award**  
*Stage - SAGE Publishing Stage*  
Chaired by: Kelly Hewett

*Powered by Ex Ordo, your online conference platform.*
Continued from Wednesday, 4 August

9:30am  General
SERVSIG: The Edge of Tomorrow: How AI Shapes the Future of Service Research
Stage - SIG Programming and Special Session Stage
Chaired by: Prof. Arne De Keyser and Prof. Dominik Mahr and Prof. Chiara Orsingher and Prof. Florian von Wangenheim

The Edge of Tomorrow: How AI Shapes the Future of Service Research
» Prof. Jan Hendrik Schumann (University of Passau), Prof. Martin Mende (Florida State University), Prof. Arne De Keyser (EDHEC Business School), Prof. Yakov Bart (Northeastern University), Prof. Xian Gu (Indiana University), Prof. Stephanie Liu (The Ohio State University), Prof. Stacey G. Robinson (The University of Alabama), Prof. P. K. Kannan (University of Maryland), Mrs. Jana Holthöwer (University of Groningen), Prof. Jenny van Doorn (University of Groningen), Prof. Gaby Odekerken-Schröder (Maastricht University), Dr. Kars Mennens (Maastricht University), Prof. Mark Steins (Maastricht University), Prof. Dominik Mahr (Maastricht University), Prof. Chiara Orsingher (University of Bologna), Prof. Katja Gelbrich (Catholic University Eichstätt-Ingolstadt), Mr. Sandro Arnet (ETH Zurich), Prof. Anne Scherer (University of Zurich), Prof. Florian von Wangenheim (ETH Zurich)

9:30am  Oral : Consumer Behavior Track - Session 5
Consumer Psychological Processes
Stage - Stage 4
Chaired by: Marcel Lichters

Does Distance Make the Heart Grow Fonder? How Product-Model Spatial Distance and Ad Appeal Influence Product Evaluation
» Mr. Dickson Tok (Nanjing University), Dr. Xi Chen (Nanjing University), Dr. Xing-Yu (Marcos) Chu (Nanjing University)

TOO LITTLE TO CLEAN IT UP: THE EFFECT OF PACKAGE SIZE ON PERCEIVED EFFICACY OF HOUSEHOLD CLEANING PRODUCT
» Ms. Yunzhi Huang (Xiamen University), Prof. Jun Ye (Department of Marketing, School of Management, Xiamen University, Xiamen)

BORED OR JOYFUL? DESIGN-DRIVEN CONSUMER EMOTIONS AND PRODUCT SUCCESS
» Ms. Heike Hebborn (University of Innsbruck), Ms. Janina S. Kuhnle (University of Innsbruck), Dr. Verena Hofmann (University of Innsbruck), Prof. Nicola Stokburger-Sauer (University of Innsbruck)

Product Bundling and Consumers’ Price Preferences
» Mr. Seyedjavad Mousavi (The University of Kansas)

B2B Relationship Development in Dynamically Changing Environment
Stage - EBSCO Stage
Chaired by: Mr. Ashish Galande and Ms. Sakshi Babar and Dr. Roberto Mora Cortez

B2B Relationship Development in Dynamically Changing Environment
» Mr. Ashish Galande (Indian Institute of Management Udaipur), Prof. Chris Dubelaar (Deakin University), Dr. Ali Tamaddoni (Deakin University), Prof. Prakash Satavageeswaran (Indian), Ms. Sakshi Babar (Indian Institute of Management Udaipur), Dr. Sundar Bharadwaj (University of Georgia), Dr. Roberto Mora Cortez (SDU), Mr. Ayan Ghosh Dastidar (Georgia State University)

The Power of Aww: A Dual-process Approach to Cuteness-affected Risk Taking and Decision-Making
» Dr. Alexis Yim (Radford University), Dr. Stephen He (West Virginia University), Dr. Annie Cui (West Virginia University)
9:30am  Oral: Services, Retailing, and Customer Experience Track - Session 1
CRM, Loyalty, and Data Privacy

Stage - Stage 5
Chaired by: Prof. Anand Kumar Jaiswal

FOSTERING THE IMPACT OF BRAND PERFORMANCE METRICS ON CUSTOMER LOYALTY: ROLE OF RELATIONAL QUALITY AND LENGTH
Prof. Hardeep Chahal (University of Jammu), Dr. Renu Bala (GCW, Parade, Jammu, J&K)

SQ-EXQUAL: A Hybrid Scale for measuring customer satisfaction and loyalty
Prof. Anand Kumar Jaiswal (IIM Ahmedabad), Dr. Suvendu Pratihari (IIM Ahmedabad)

How Do Relationship Characteristics Affect Point Redemption Behavior in the Coalition Loyalty Programs?
Dr. Chen Li (Palm Beach Atlantic University), Dr. Srinivasan Swaminathan (Drexel University), Dr. Junhee Kim (California State University, Stanislaus)

Using Customer Education to Boost Positive Word-of-Mouth
Ms. Xiaochi Sun (University of Graz), Prof. Thomas Foscht (University of Graz), Prof. Andreas B. Eisengerich (Imperial College London), Dr. Cesar Maloles (California State University, East Bay), Dr. Xuebin Cui (Nanjing University)

DIGITAL TECHNOLOGIES AND SHOPPING: AN EXPLORATORY STUDY
Prof. Piyush Sharma (Curtin University), Dr. Akiko Ueno (Middlesex University), Prof. Charles Dennis (Middlesex University), Dr. Ceyda Paydas Turan (Kingston University London)

10:30am  Workshop
Speaker Set Up
Stage - Plenary Stage

11am  Keynote
Innovation Session
Stage - Plenary Stage

Conjoint Analysis in Market Research
Mr. Cameron Halverson (Sawtooth Software)

Why Hubro Marketing is "the best learning experience I've ever had"
Mr. Emil Oliver (Hubro Education)

Experiential Learning of Marketing Concepts Via Immersive Business Simulations
Mr. Josh Derry (Knowledge Matters)
<table>
<thead>
<tr>
<th>Time</th>
<th>Session</th>
<th>Stage</th>
<th>Chair(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>12:15pm</td>
<td><strong>Workshop</strong> Speaker Set Up</td>
<td>SAGE Publishing Stage</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Workshop</strong> Speaker Set Up</td>
<td>SIG Programming and Special Session Stage</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Workshop</strong> Speaker Set Up</td>
<td>EBSCO Stage</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Workshop</strong> Speaker Set Up</td>
<td>Stage 4</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Workshop</strong> Speaker Set Up</td>
<td>Stage 5</td>
<td></td>
</tr>
<tr>
<td>12:30pm</td>
<td><strong>General</strong> AMA Meet the Editors Part 1 - Methods</td>
<td>SAGE Publishing Stage</td>
<td>Dr. Koen Pauwels</td>
</tr>
<tr>
<td></td>
<td><strong>General</strong> SportSIG: Reimagining Sport &amp; Sponsorship-Linked Marketing</td>
<td>SIG Programming and Special Session Stage</td>
<td>Dr. Ashley Stadler Blank and Mr. Keevan Statz and Dr. Yiran Su and Dr. Michael L. Naraine and Dr. Lane Wakefield</td>
</tr>
<tr>
<td></td>
<td><strong>General</strong> AMA Foundation</td>
<td>Marketing Research's Impact on the Future of the Marketing Industry</td>
<td>EBSCO Stage</td>
</tr>
</tbody>
</table>

*Powered by Ex Ordo, your online conference platform.*
Continued from Wednesday, 4 August

AMA Foundation | Marketing Research’s Impact on the Future of the Marketing Industry
» Prof. Doug Holt (Founder, and President, Cultural Strategy Group),
  Prof. Jerry Olson (Founding Partner, Olson Zaltman, and Professor Emeritus, The Pennsylvania State University), Mr. J Walker-Smith (Executive Chairman of Kantar Futures)

12:30pm

Oral: Sustainability, Social Responsibility and Public Policy Track - Session 3
Corporate Social Responsibility
Stage - Stage 4
Chaired by: Mr. Ayan Ghosh Dastidar

Advertising For Social Good
» Mr. Ayan Ghosh Dastidar (Georgia State University), Dr. Sarang Sunder (Texas Christian University), Dr. Denish Shah (Georgia State University)

Is more always better? Product availability, consumption and marketing influences at the Bottom of the Pyramid
» Ms. Shehzala - (IIM Ahmedabad), Prof. Anand Kumar Jaiswal (IIM Ahmedabad), Dr. Vidya Vemireddy (IIM Ahmedabad)

Does Environmental Responsibility Beat Convenience in Online Shopping? An Investigation of Excessive Packaging, Customer Anger and Loyalty
» Mr. Simon Eschenbroich (Universität Innsbruck), Mr. Benedikt Schnurr (Technical University Munich), Prof. Nicola Stokburger-Sauer (Universität Innsbruck)

Individualism and collectivism as moderators of the relationship between norms and pro-environmental consumer behavior
» Ms. Selma Saracevic (The Institute for International Marketing Management, WU: Vienna University of Economics and Business), Prof. Bodo Schlegelmilch (The Institute for International Marketing Management, WU: Vienna University of Economics and Business), Dr. Tong Wu (School of Business, Sun Yat-sen University)

12:30pm

Oral: Sustainability, Social Responsibility and Public Policy Track - Session 4
Emerging Topics in Sustainability
Stage - Stage 5
Chaired by: Dr. Vidya Vemireddy

SYSTEMATIC AND ETHICAL APPROACH TO FOOD EXPERIENCE DESIGN
» Prof. Michela Addis (Università degli Studi Roma Tre), Prof. Wided Batat (EM Normandie Business School), Dr. S. Sinem Atakan (Siena College), Prof. C. Graham Austin (Montana State University), Prof. Danae Manika (Brunel University London), Prof. Paula Peter (San Diego State University), Dr. Lane Peterson (Georgia State University)

PRESCRIBED MEDICATION CONSUMPTION FOR CHRONIC ILLNESS: AN UNFOLDING, NARRATIVE, EXPERIENCE PERSPECTIVE
» Dr. Cheryl Nakata (The University of North Carolina at Greensboro), Dr. Lisa Sharp (University of Illinois at Chicago), Dr. Jelena Spanjol (Ludwig-Maximilians-Universität), Prof. Anna Shaojie Cui (University of Illinois at Chicago), Dr. Elif Izberk-Bilgin (University of Michigan-Dearborn), Dr. Stephanie Crawford (University of Illinois at Chicago), Dr. Yazhen Xiao (University of Tennessee)

STRATEGY FORMULATION FOR CORPORATE SOCIAL RESPONSIBILITY: TOWARDS A DECISION-MAKING MODEL USING FUZZY APPROACH
» Dr. Aswathy Asokan Ajitha (Indian Institute of Management Amritsar), Dr. Rejikumar G (Amrita Vishwa Vidyapeetham)

Algorithmic Interference: Infringement on Forming Intimate Associations and the Manipulation of Weak Ties
» Dr. Patricia Norberg (Quinnipiac University), Dr. Daniel Horne (Providence College)
<table>
<thead>
<tr>
<th>Time</th>
<th>Session</th>
</tr>
</thead>
<tbody>
<tr>
<td>12:30pm</td>
<td>Oral: Branding, Innovation and the 4Ps Track - Session 1</td>
</tr>
<tr>
<td></td>
<td>Firm Strategies for Introducing Innovations</td>
</tr>
<tr>
<td></td>
<td><strong>Stage - Stage 6</strong></td>
</tr>
<tr>
<td></td>
<td>Chaired by: Dr. Jake Hoskins</td>
</tr>
<tr>
<td>1:45pm</td>
<td>Workshop</td>
</tr>
<tr>
<td></td>
<td>Speaker Set Up</td>
</tr>
<tr>
<td></td>
<td><strong>Stage - EBSCO Stage</strong></td>
</tr>
<tr>
<td>1:45pm</td>
<td>Workshop</td>
</tr>
<tr>
<td></td>
<td>Speaker Set Up</td>
</tr>
<tr>
<td></td>
<td><strong>Stage - Stage 4</strong></td>
</tr>
<tr>
<td>1:45pm</td>
<td>Workshop</td>
</tr>
<tr>
<td></td>
<td>Speaker Set Up</td>
</tr>
<tr>
<td></td>
<td><strong>Stage - Stage 5</strong></td>
</tr>
<tr>
<td>1:45pm</td>
<td>Workshop</td>
</tr>
<tr>
<td></td>
<td>Speaker Set Up</td>
</tr>
<tr>
<td></td>
<td><strong>Stage - Stage 6</strong></td>
</tr>
<tr>
<td>2pm</td>
<td>General</td>
</tr>
<tr>
<td></td>
<td>JOURNAL OF MARKETING AWARDS SESSION: AMA/MSI/ROOT WINNER</td>
</tr>
<tr>
<td></td>
<td><strong>Stage - SAGE Publishing Stage</strong></td>
</tr>
<tr>
<td>2pm</td>
<td>General</td>
</tr>
<tr>
<td></td>
<td>Analytics Insights for Public Policy &amp; Marketing</td>
</tr>
<tr>
<td></td>
<td><strong>Stage - EBSCO Stage</strong></td>
</tr>
</tbody>
</table>

Rhetoric-Based Signals of Quality and Narrative Meaning in Crowdfunding Campaigns for New Ideas: Evidence from Kickstarter
» Dr. Mohammad Tajvarpour (State University of New York at Oswego), Dr. Ashish Pujari (McMaster University, DeGroote School of Business)

Market Selection and Product Positioning Decisions and their Implications for Short- and Long-Term Performance
» Dr. Jake Hoskins (Willamette University), Dr. Abbie Griffin (University of Utah)

Joint Moderating Effects of Innovation Radicalness and Lead Userness on Customer Participation in Different Stages on New Product Development Performance
» Dr. Hyeyeon Yuk (Korea University Business School), Dr. Tony Garrett (Korea University Business School), Dr. Woojung Chang (University of Seoul)

TURNING A CRISIS INTO AN OPPORTUNITY – INNOVATION DURING THE PANDEMIC
» Dr. Francesca Bonetti (London College of Fashion), Dr. Alessandra Vecchi (London College of Fashion)

Powered by Ex Ordo, your online conference platform.
Analytics Insights for Public Policy & Marketing
» Dr. Brennan Davis (Cal Poly), Dr. Dhruv Grewal (Babson College)

2pm
Oral: B2B Marketing, Supply Chain Management and Sales Management Track - Session 1
Advances in Research on Interorganizational Relationships
Stage - Stage 4
Chaired by: Dr. Swati Panda

Customer–Salesperson Negotiations in Times of Crisis
» Ms. Claire Cardy (University of Warwick), Prof. Johannes Habel (University of Houston), Dr. Olaf Ploetner (ESMT Berlin), Dr. Nawar Chaker (Louisiana State University)

New Service Development Performance: Examining the Roles of Customer Participation Scope and Customer Relationship Management in Servitization
» Dr. Todd Morgan (Western Michigan University), Dr. Wesley Friske (Missouri State University), Dr. Paul Mills (Cleveland State University)

Project Termination: Alliance Portfolio Characteristics and NPD Project Performance
» Dr. Hadi Eslami (University of New Brunswick), Dr. Farhad Sadeh (Eastern Illinois University), Dr. Kamran Eshghi (Laurentian University)

Bidirectional agency relationships in solution selling: How supplier and customer opportunism impedes customer acceptance of outcome-based pricing
» Dr. Eva Kropp (University of Passau), Prof. Dirk Totzek (University of Passau)

2pm
Oral: Consumer Behavior Track - Session 6
Ethics, Privacy, and Wellbeing
Stage - Stage 5
Chaired by: Ms. Stella Tavallaee

Let’s go, bananas! - How emotionalized humanization increases consumers' liking of imperfect food produce
» Ms. Svenja Hünies (RWTH Aachen University), Prof. Daniel Wentzel (RWTH Aachen University)

Examining Situational Skepticism due to Health-related Claims on Packaged Food Products and its Effect on Product Purchase Intention
» Ms. Vartika Chaudhary (IIT Bombay), Prof. Dinesh Sharma (IIT Bombay), Prof. Anish Nagpal (University of Melbourne)

Consequences of Consumer Burnout
» Ms. Hannah Southern (Elon University), Dr. Prachi Gala (Elon University)

EMOTIONAL INTELLIGENCE AND MATERIALISM: THE MEDIATING EFFECT OF SUBJECTIVE WELL-BEING
» Dr. Beata Seinauskiene (Kaunas University of Technology), Dr. Ausra Rutelione (Kaunas University of Technology), Dr. Shahrokh Nikou (Åbo Akademi University), Dr. Rosita Lekavičienė (Kaunas University of Technology), Prof. Dalia Antinienė (Lithuanian University of Health Sciences)

AN EXPLORATORY ASSESSMENT OF CONSUMER EMOTIONAL INTELLIGENCE IN CONSUMER ETHICAL DECISION MAKING
» Dr. Hannah Walters (Northern State University)

2pm
Oral: Social Media and Digital Marketing Track - Session 3
The Impact of Social Media Advertising, Online Advertising, and Online Search
Stage - Stage 6
Chaired by: Dr. Verena Hofmann

Owned Social Media Advertising: Cannibalization and Competition
» Prof. Hualu Zheng (Professor), Prof. Lu Huang (New York Institute of Technology)
Continued from Wednesday, 4 August

<table>
<thead>
<tr>
<th>Time</th>
<th>Event</th>
<th>Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>3:15pm</td>
<td>Workshop Speaker Set Up</td>
<td>EBSCO Stage</td>
</tr>
<tr>
<td>3:15pm</td>
<td>Workshop Speaker Set Up</td>
<td>Stage 4</td>
</tr>
<tr>
<td>3:15pm</td>
<td>Workshop Speaker Set Up</td>
<td>Stage 5</td>
</tr>
<tr>
<td>3:15pm</td>
<td>Workshop Speaker Set Up</td>
<td>Stage 6</td>
</tr>
<tr>
<td>3:30pm</td>
<td>General Journal of Marketing Award Session: Sheth Foundation/JM Award &amp; Shelby D. Hunt/Harold H. Maynard Award</td>
<td>SAGE Publishing Stage</td>
</tr>
</tbody>
</table>

**Is Disclosure Good for Online Ad Effectiveness? The Crowd Safety Effect of Collective-Based Transparency**

» Dr. Junjun Cheng (SILC Business School, Shanghai University), Dr. Bo Chen (Sungkyunkwan University)

**THE ANCHORING EFFECT IN ONLINE SEARCH**

» Dr. Satadruta Mookherjee (NEOMA Business School), Dr. Abhimanyu Bhattacharya (University of Alabama), Mr. Herman Blote (University of Groningen)

**SMILE?! – THE ROLE OF CONSUMERS’ SELF-CONSTRUAL, ENDORSERS’ EMOTIONS AND AD APPEAL FOR SOCIAL MEDIA COMMUNICATION SUCCESS**

» Ms. Lisa Schwayer (University of Innsbruck), Prof. Nicola Stokburger-Sauer (Universität Innsbruck), Dr. Verena Hofmann (University of Innsbruck)

**Effects of Social Media Ads on New Product Perception and Behavioral Intention**

» Ms. Kaitlin R. Lane (Montana State University), Dr. Eric Van Steenburg (Montana State University)

**How Does the Adoption of Ad Blockers Affect News Consumption?**

» Ms. Shunyao Yan (Goethe University Frankfurt), Prof. Klaus Miller (Goethe University Frankfurt), Prof. Bernd Skiera (Goethe University Frankfurt)
Continued from Wednesday, 4 August

3:30pm **General**


*Stage - SIG Programming and Special Session Stage*

Chaired by: Dr. Stacy Wood and Dr. Kevin Schulman

  - **Dr. Stacy Wood** (North Carolina State University)

3:30pm **General**

**Representations Matters: Celebrating Scholars of Color in the Classroom**

*Stage - EBSCO Stage*

Chaired by: Prof. Maura Scott and Prof. Nicole Ann Davis and Prof. Shawn Enriques

- Representations Matters: Celebrating Scholars of Color in the Classroom
  - **Prof. Maura Scott** (Florida State University), **Prof. Nicole Ann Davis** (University of Georgia), **Prof. Shawn Enriques** (University of Wyoming)

3:30pm **Oral: Social Media and Digital Marketing Track - Session 4**

**Social Media, Social Networking, and the Role of Sentiment and Satisfaction**

*Stage - Stage 4*

Chaired by: Ms. Ashley Hass

- THE PERCEPTION OF CONSUMER ENVY ON SOCIAL NETWORKING SITES
  - **Dr. MURONG MIAO** (Northern Michigan University), **Dr. Yi Peng** (Tennessee Tech University)

- Why do users participate in Social Commerce? Changing Trends and Insights from a longitudinal study?
  - **Mr. Ashish Kakar** (Texas Tech University), **Dr. Adarsh Kumar Kakar** (Alabama State University)

- Platform Pricing in the Presence of Cross-platform Network Effects
  - **Ms. Betty Ji** (McMaster University, DeGroote School of Business), **Dr. Ruhai Wu** (McMaster University, DeGroote School of Business)

- Returns to Social Media and the Role of Customer Satisfaction
  - **Mr. Pushpinder Gill** (Iowa State University), **Dr. Sridhar Ramaswami** (Iowa State University), **Ms. Preetinder Kaur** (Iowa State University)

- Fanning the Flames: Understanding Viral Content After Brand Transgressions
  - **Dr. Kimberly Legocki** (St. Mary’s College), **Dr. Kristen Walker** (California State University, Northridge), **Dr. Meike Eilert** (University of Kentucky)

- INTEGRATED FRAMEWORK FOR RECOMMENDATION SYSTEM PARTICIPATION AND OUTCOMES
  - **Mr. An Vu** (Victoria University of Wellington), **Dr. Mary Ellen Gordon** (Victoria University of Wellington), **Dr. Jocelyn Cranefield** (Victoria University of Wellington)

3:30pm **Oral: International & Cross-Cultural Marketing Track - Session 1**

**Cross-national Consumer Behavior Research**

*Stage - Stage 5*

Chaired by: Prof. Gianfranco Walsh

- INFLUENCE OF EMOTIONAL VENTING ON THE EFFECT OF CONSUMER ANIMOSITY
  - **Dr. Yi Peng** (Tennessee Tech University), **Dr. MURONG MIAO** (Northern Michigan University), **Mr. Siyuan Yang** (Tennessee Tech University)

- What Drives Opinion Leadership Within Ethnic Subgroups?
  - **Prof. Gianfranco Walsh** (Ulvit of Jena), **Prof. Ayalla Ruvio** (Broad College of Business), **Prof. Mario Schaarschmidt** (Ulvit of Jena)
Continued from Wednesday, 4 August

A CROSS-CULTURAL INVESTIGATION OF CONSUMER IMPULSIVE BUYING BEHAVIOR DURING THE COVID-19 PANDEMIC
» Ms. Pei Wang (Florida State University), Dr. Sindy Chapa (Florida State University)

Consequences of Unethical Firm Behavior: How do consumers evaluate local brands and global brands that behave unethically
» Ms. Irem Yoruk (Wayne State University), Dr. Attila Yaprak (Wayne State University)

3:30pm Oral: Marketing Analytics, AI, Machine Learning Track - Session 1
Recent Trends in AI and Machine Learning
Stage - Stage 6
Chaired by: Dr. Xianfang Zeng

Advice and Artificial Intelligence: Why and When to Seek Advice from Humans Versus Machines
» Dr. Xianfang Zeng (University of Wisconsin–River Falls)

Conducting relevant generalizations of past results in Marketing research: Introduction to the one-stage meta-analytic structural equation modeling.
» Dr. Kathleen Desveaud (TSM-Research, Université Toulouse Capitole, CNRS), Prof. Mike WL Cheung (National University of Singapore)

Distributive justice and welfare values of blockchain-based smart contracts
» Prof. Nir Kshetri (University of North Carolina at Greensboro)

A Text Mining Approach to Generate Actionable Intelligence & Identify Key Drivers of City Competitiveness
» Mr. Ayan Ghosh Dastidar (Georgia State University), Dr. Denish Shah (Georgia State University)

5pm Oral: Marketing Analytics, AI, Machine Learning Track - Session 1
Consequences of Unethical Firm Behavior: How do consumers evaluate local brands and global brands that behave unethically
» Ms. Irem Yoruk (Wayne State University), Dr. Attila Yaprak (Wayne State University)

Thursday, 5 August

7:45am Workshop
Speaker Set Up
Stage - SIG Programming and Special Session Stage

7:45am Workshop
Speaker Set Up
Stage - EBSCO Stage

7:45am Workshop
Speaker Set Up
Stage - Stage 4
<table>
<thead>
<tr>
<th>Time</th>
<th>Workshop</th>
</tr>
</thead>
<tbody>
<tr>
<td>8am</td>
<td><strong>Workshop: Writing</strong></td>
</tr>
<tr>
<td></td>
<td>How to craft a great manuscript for publication?</td>
</tr>
<tr>
<td></td>
<td>Stage - SAGE Publishing Stage</td>
</tr>
<tr>
<td></td>
<td>Chaired by: Prof. Werner Reinartz</td>
</tr>
<tr>
<td></td>
<td>How to craft a great manuscript for publication?</td>
</tr>
<tr>
<td></td>
<td>» Prof. Werner Reinartz (University of Cologne)</td>
</tr>
<tr>
<td></td>
<td><strong>Workshop: Skills - Experimental Methods</strong></td>
</tr>
<tr>
<td></td>
<td>Experimental methods: Social media field experiments</td>
</tr>
<tr>
<td></td>
<td>Stage - SIG Programming and Special Session Stage</td>
</tr>
<tr>
<td></td>
<td>Chaired by: Prof. David Rand</td>
</tr>
<tr>
<td></td>
<td>Experimental Methods</td>
</tr>
<tr>
<td></td>
<td>» Prof. David Rand (MIT)</td>
</tr>
<tr>
<td>8am</td>
<td><strong>Workshop: Inspirational - Responsible Research</strong></td>
</tr>
<tr>
<td></td>
<td>Responsible Research: Marketplace Access, Equity, and Power</td>
</tr>
<tr>
<td></td>
<td>Stage - EBSCO Stage</td>
</tr>
<tr>
<td></td>
<td>Chaired by: Prof. Sterling Bone</td>
</tr>
<tr>
<td></td>
<td>Responsible Research: Marketplace Access, Equity, and Power</td>
</tr>
<tr>
<td></td>
<td>» Prof. Sterling Bone (Utah State University)</td>
</tr>
<tr>
<td>8am</td>
<td><strong>Workshop: Skills - Addressing Endogeneity Part 2</strong></td>
</tr>
<tr>
<td></td>
<td>Addressing endogeneity Part 2: Advanced approaches in addressing endogeneity</td>
</tr>
<tr>
<td></td>
<td>Stage - Stage 4</td>
</tr>
<tr>
<td></td>
<td>Chaired by: Prof. Dominik Papies and Prof. Peter Ebbes</td>
</tr>
<tr>
<td></td>
<td>Addressing endogeneity Part 2: Advanced approaches in addressing endogeneity</td>
</tr>
<tr>
<td></td>
<td>» Prof. Dominik Papies (University of Tuebingen), Prof. Peter Ebbes</td>
</tr>
<tr>
<td></td>
<td>(HEC Paris)</td>
</tr>
</tbody>
</table>

**9:15am**  
Workshop  
Speaker Set Up  
Stage - SAGE Publishing Stage

**9:15am**  
Workshop  
Speaker Set Up  
Stage - SIG Programming and Special Session Stage

**9:15am**  
Workshop  
Speaker Set Up  
Stage - Stage 4

**9:15am**  
Workshop  
Speaker Set Up  
Stage - Stage 5

**9:15am**  
Workshop  
Speaker Set Up  
Stage - Stage 6

**9:30am**  
General  
JOURNAL OF PUBLIC POLICY & MARKETING AWARDS SESSION | Thomas C. Kinneear/ Journal of Public Policy & Marketing Award  
Stage - SAGE Publishing Stage  
Chaired by: Kelly Martin and Maura Scott
Continued from Thursday, 5 August

9:30am  General
RM SIG Special Session: Editorial Perspectives on Relationship Marketing Research
*Stage - SIG Programming and Special Session Stage*
Chaired by: Hui Feng and Alok Saboo and Naveen Donthu and Dr. Kelly Hewett and JOHN HULLAND and Prof. Werner Reinartz

9:30am  Oral : Sustainability, Social Responsibility and Public Policy Track - Session 1
Sustainability and Triple Bottom Line Performance
*Stage - Stage 4*
Chaired by: Dr. Fabio Shimabukuro Sandes

**Feeling small but thinking big: Awe-induced positive self-diminishment motivates sustainable consumption**
» Ms. Srinwanti Chaudhury (University of New South Wales), Dr. Nitika Garg (University of New South Wales), Dr. Colin Gabler (Ohio University)

**Environmental, Social, and Corporate Governance Strategic Group Dynamics and the Role of the Chief Marketing Officer and Chief Sustainability Officer**
» Dr. Charles Kang (University of Wisconsin-Milwaukee)

**Sustainability positioning in retail: latent semantic analysis of social media marketing communication**
» Ms. Nadezda Kolesnik (National Research University Higher School of Economics)

9:30am  Oral : Consumer Behavior Track - Session 7
Social Relationships and Identities
*Stage - Stage 5*
Chaired by: Monika Imschloss

**How Linguistic Style Affects Word-of-Mouth’s Persuasion Effect over Different Identity Source**
» Dr. Jie Chen (Shanghai jiao Tong University Antai College of Economics and Management), Ms. Wenjian Fan (Shanghai jiao Tong University Antai College of Economics and Management), Mr. Junlong Wei (Shanghai jiao Tong University Antai College of Economics and Management), Dr. Zunli Liu (Shanghai University of Engineering Science)

**Antecedents of Bundle Purchases - The Influence of the Customer-Retailer Relationship and Browsing on Bundle Purchases**
» Ms. Marie-Therese von Buttlar (RWTH Aachen University), Dr. Andrea Greven (RWTH Aachen University), Prof. Malte Brettel (RWTH Aachen University)

**Visual Illusion of Truth Effect**
» Ms. Farhana Tabassum (BI Norwegian Business School), Dr. Klemens Knoeferle (BI Norwegian Business School), Prof. Luk Warlop (BI Norwegian Business School)

**THE EFFECT OF TYPOGRAPHY ON BRAND CREDIBILITY: THE MEDIATING ROLE OF THE MESSAGE PERSONA**
» Mrs. Deniz Ozbayrak (Istanbul Bilgi University), Dr. Nesenur Altinigne (Istanbul Bilgi University)
**2021 AMA Summer Academic Conference 04 - 06 Aug 2021 All times in CDT**

### 9:30am

**Oral : Social Media and Digital Marketing Track - Session 5**

**Online Reviews and User-Generated Content**

*Stage - Stage 6*

Chaired by: Dr. Jake Hoskins

#### "You Are Kicked Out of the Room Now!": The Impact of Social Exclusion on User-Generated Content in Online Communities

» Ms. Xiaochi Sun (University of Graz), Prof. Thomas Foscht (University of Graz), Prof. Andreas B. Eisingerich (Imperial College London), Dr. 刚吴 (Sichuan University), Dr. Xuebin Cui (Nanjing University)

#### It's a Man's World? Male Dominance of a Product's Online Community and its Implications for Review Volume, Review Valence and Review Diversity

» Dr. Shelly Rathee (Villanova University), Dr. Jake Hoskins (Willamette University)

#### The moderating role of marketplace organic search on earned social media and user-generated content: a multilevel multichannel retailing assessment

» Dr. Valter Vieira (State University of Maringá), Dr. Marcos Almeida (Federal University of Goiás), Dr. Thomas Schreiner (University of Hamburg)

### 10:30am

**Workshop**

**Speaker Set Up**

*Stage - Plenary Stage*

### 11am

**Keynote**

**Awards Celebration**

*Stage - Plenary Stage*

### 12:15pm

**Workshop**

**Speaker Set Up**

*Stage - SAGE Publishing Stage*

**Workshop**

**Speaker Set Up**

*Stage - SIG Programming and Special Session Stage*

### 12:15pm

**Workshop**

**Speaker Set Up**

*Stage - EBSCO Stage*
Continued from Thursday, 5 August

<table>
<thead>
<tr>
<th>Time</th>
<th>Event</th>
<th>Location</th>
<th>Chairers</th>
</tr>
</thead>
<tbody>
<tr>
<td>12:15pm</td>
<td>Workshop Speaker Set Up</td>
<td>Stage - Stage 4</td>
<td></td>
</tr>
<tr>
<td>12:15pm</td>
<td>Workshop Speaker Set Up</td>
<td>Stage - Stage 5</td>
<td></td>
</tr>
<tr>
<td>12:15pm</td>
<td>Workshop Speaker Set Up</td>
<td>Stage - Stage 6</td>
<td></td>
</tr>
<tr>
<td>12:30pm</td>
<td>Recent Developments in Marketing Strategies in Competitive Environment</td>
<td>SAGE Publishing Stage</td>
<td>Dr. V Kumar and Dr. Ankit, Dr. Ashley Goreczny, and Dr. Amalesh Sharma and Dr. Yusuf Oc</td>
</tr>
</tbody>
</table>

12:30pm    General

**Recent Developments in Marketing Strategies in Competitive Environment**
- Dr. V Kumar (Indian School of Business), Dr. Ankit Anand (Texas Tech University), Mr. Amit Agarwal (Georgia State University), Dr. Ashley Goreczny (Iowa State University), Ms. Heather Patterson (Iowa State University), Dr. Amalesh Sharma, Dr. Yusuf Oc (King's College London), Dr. Stefan Bernritter (King's College London)

12:30pm    EM SIG: Meet the Editors Special Session for Entrepreneurial Marketing Research

**Stage - SIG Programming and Special Session Stage**

Chaired by: Dr. Wesley Friske and Dr. Todd Morgan

Meet the Editors Special Session for Entrepreneurial Marketing Research
- Prof. Fabian Eggers (Associate Editor, Journal of Business Research, Menlo College), Prof. James Crick (Associate Editor, Strategic Journal of Marketing, Loughborough University), Prof. Terrence Brown (Editor in Chief, International Journal of Entrepreneurial Venturing, KTH Royal Institute of Technology), Prof. Victoria Crittenden (Editor in Chief, Journal of Marketing Education, Babson College), Prof. Zubin Sethna (Editor in Chief, Journal of Research in Marketing and Entrepreneurship, Regent's University London), Dr. Wesley Friske (Missouri State University), Dr. Todd Morgan (Western Michigan University)

12:30pm    Oral: Sustainability, Social Responsibility and Public Policy Track - Session 2

**Sustainability, Branding and Public Policy**

Chaired by: Dr. Abhijit Roy

- **Eco-product labeling: The moderating effect of environmental marketing, consumer purchasing evaluation and competitive advantage**
  - Ms. Debra Lee Surface (University of Massachusetts Lowell)

- **The role of brands in second-hand product consumption.**
  - Dr. Fabio Shimabukuro Sandes (Universidade Lusófona, CICANT)

- **Group Factors Affecting Consumers’ Behavioral Intentions toward Suboptimal Food Products: Perspectives from Consumer Choice Theory and Theory of Planned Behavior**
  - Mr. Ahmed M. Adel (Huazhong University of Science and Technology), Prof. Xin Dai (Huazhong University of Science and Technology), Mrs. Rana S. Rosdy (Huazhong University of Science and Technology)
Continued from Thursday, 5 August

BRAND ACTIVISM AND CONSUMER ENGAGEMENT
» Ms. Seoyoung Kim (University of Georgia), Dr. Sundar Bharadwaj (University of Georgia)

Promises and Perils of Consumer Well-Being in the Epoch of IR 4.0: Macro-Behavioral Implications
» Dr. Abhijit Roy (University of Scranton)

12:30pm Oral: Services, Retailing, and Customer Experience Track - Session 5
Retailing and the Customer Experience
Stage - Stage 4
Chaired by: Mr. Olivier Reimann

PLUS-SIZE SHOPPERS’ PERCEPTIONS OF THE PLUS-SIZE WOMEN’S APPAREL INDUSTRY
» Dr. Mavis Adjei (Southern Illinois University Carbondale), Ms. Joy Madison (Southern Illinois University Carbondale), Dr. Joanna Melancon (Western Kentucky University), Dr. Frederick Adjei (Southeast Missouri State University)

THE IMPACT OF GUARDIANSHIP POLICIES ON FRONTLINE EMPLOYEES
» Dr. Patrick Fennell (Salisbury University), Dr. Melanie Lorenz (Florida Atlantic University), Dr. James “Mick” Andzulis (Ohio University)

Always On My Mind? - Antecedents of Private Label Share in Consumers’ Consideration Sets
» Mr. Lukas Stoppacher (University of Graz), Prof. Thomas Foscht (University of Graz), Dr. Judith Schloffer (University of Graz)

Attitude Formation Toward Economy, Standard and Premium Private Label
» Mr. Olivier Reimann (ZHAW - School of Management and Law), Dr. Oliver Thomas (ZHAW - School of Management and Law), Prof. Gunther Kucz (ZHAW - School of Management and Law)

Business Customer Experience in B2B2C: A Scale Development
» Dr. Rejikumar G (Amrita Vishwa Vidyapeetham), Dr. Aswathy Asokan Ajitha (Indian Institute of Management Amritsar)

12:30pm Oral: Consumer Behavior Track - Session 2
Behavioral Outcomes of Marketing Strategy
Stage - Stage 5
Chaired by: Karen Anne Wallach

Voice Assistants, Social Norms, and Prosocial Behavior
» Ms. Smaraki Mohanty (Binghamton University, State University of New York), Dr. Iman Paul (Clarkson University), Dr. Samuel Bond (Georgia Tech)

Expanding self-extension theory in the Internet of Things
» Ms. Min Yan (newcastle university), Prof. Raffaele Filieri (Audencia Business School), Prof. Matthew Gorton (newcastle university)

Old is not always Gold: The role of Temporal Congruence in shaping the downstream effects of Firm’s Longevity
» Ms. Shweta Isha (Indian Institute of Management, Indore, India), Prof. Sanjeev Tripathi (Indian Institute of Management, Indore, India), Prof. Sudipta Mandal (Indian Institute of Management, Indore, India)

Customer’s package-size choice decision at the bottom of the pyramid (BOP) market
» Dr. Suvenu Pratihari (IIM Ahmedabad), Prof. Anand Kumar Jaiswal (IIM Ahmedabad)

The bright and dark side of credit card usage by low-income consumers
» Dr. Farah Diba Abrantes-Braga (Insper (www.insper.edu.br)), Dr. Danny P. Claro (Insper (www.insper.edu.br))

12:30pm Oral: Services, Retailing, and Customer Experience - Session 2
E-Commerce
Stage - Stage 6
Chaired by: Dr. Zahy Ramadan
Continued from **Thursday, 5 August**

### Adding Clicks to Clicks: Exploring the Impact of Encroachment on Online Incumbents

» Mr. Karthikeyan Balakumar (Indian Institute of Management Calcutta), Dr. Prafulla Agnihotri (Vijay Patil School of Management), Dr. Ritu Mehta (Indian Institute of Management Calcutta), Dr. Debabrata Ghosh (Malaysia Institute for Supply Chain Innovation)

**Fool me once, shame on you; fool me twice, shame on Amazon Prime**

» Dr. Zahy Ramadan (Lebanese American University), Dr. Maya Farah (Lebanese American University), Ms. Rana Bou Saada (Lebanese American University)

### Subscription commerce: an attachment theory perspective

» Mr. René Hubert Kerschbaumer (University of Graz), Mr. Daniel Kreimer (University of Graz), Prof. Thomas Foscht (University of Graz), Prof. Andreas B. Eisingerich (Imperial College London)

### THE ROLE OF CUSTOMERS’ PERCEIVED VALUE IN THE PRIVACY PARADOX

» Mr. David Fehrenbach (WWU Münster), Dr. Carolina Herrando (University of Twente)

<table>
<thead>
<tr>
<th>Time</th>
<th>Event</th>
<th>Stage</th>
</tr>
</thead>
<tbody>
<tr>
<td>1:45pm</td>
<td><strong>Workshop</strong> Speaker Set Up</td>
<td>EBSCO Stage</td>
</tr>
<tr>
<td>1:45pm</td>
<td><strong>Workshop</strong> Speaker Set Up</td>
<td>Stage - 4</td>
</tr>
<tr>
<td>1:45pm</td>
<td><strong>Workshop</strong> Speaker Set Up</td>
<td>Stage - 5</td>
</tr>
<tr>
<td>1:45pm</td>
<td><strong>Workshop</strong> Speaker Set Up</td>
<td>Stage - 6</td>
</tr>
<tr>
<td>2pm</td>
<td><strong>General</strong> JOURNAL OF MARKETING RESEARCH AWARDS SESSION</td>
<td>SAGE Publishing Stage</td>
</tr>
<tr>
<td></td>
<td><strong>PAUL E. GREEN AWARD</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Chaired by: Dr. Vikas Mittal</td>
<td></td>
</tr>
</tbody>
</table>

**1:45pm Workshop Speaker Set Up**
Stage - SAGE Publishing Stage

**1:45pm Workshop Speaker Set Up**
Stage - SIG Programming and Special Session Stage
Continued from Thursday, 5 August

### 2pm

**General**

**RAPSIG: Naked, Embarrassing, Cancelled, and Haptic: The Art of Selling Products to a New Generation**

*Stage - SIG Programming and Special Session Stage*

Chaired by: Dr. Stephanie Noble and Dr. Stacey Robinson

- Naked, Embarrassing, Cancelled, and Haptic: The Art of Selling Products to a New Generation
  - Dr. Stephanie Noble *(University of Tennessee)*
  - Dr. Stacey Robinson *(The University of Alabama)*
  - Dr. Courtney Szocs *(Louisiana State University)*
  - Prof. Carol Jones *(University of Alabama)*
  - Dr. Lauren Beitelspacher *(Babson College)*
  - Dr. Subhash Jha *(The University of Memphis)*

**Oral: Consumer Behavior Track - Session 3**

**Brands and Consumers**

*Stage - EBSCO Stage*

Chaired by: Dr. Kaisa Lund

- Framing brand misbehavior: Exploring the effects of moral intensity frames on boycott intention
  - Dr. Olivia Bravo *(University of the West Indies)*
  - Dr. Sindy Chapa *(Florida State University)*

- The Influence of Perceived Movement on Consumer Responses to Brand Recovery Efforts
  - Dr. Laura Boman *(Mercer University)*
  - Dr. Lam An *(University of Winnipeg)*
  - Dr. Ganga Hewage *(Bryant University)*
  - Dr. Jonathan Hasford *(University of Tennessee - Knoxville)*

**EFFECTIVE MESSAGING STRATEGIES FOR SOCIOPOLITICAL ACTIVIST BRANDS**

- Mr. Fayez Ahmad *(University of North Texas)*
- Dr. Francisco Guzmán *(University of North Texas)*

### 2pm

**Oral: Consumer Behavior Track - Session 1**

**Digital Marketing**

*Stage - Stage 4*

Chaired by: Franziska Krause

- Mobile Push Notification Effectiveness: The Role of the Consumer-firm Relationship and Browsing Behavior
  - Ms. Marie-Josefien Schneider *(RWTH Aachen University)*
  - Dr. Jan Kemper *(RWTH Aachen University)*
  - Prof. Malte Brettel *(RWTH Aachen University)*

- Download This App for Our Own Sake: Factors Influencing Users’ Download Intention
  - Dr. Robin Robin *(Oxford Brookes University)*
  - Dr. Ala’ Dandis *(Applied Science Private University)*

- Consumers’ De-ownership as a Predictor of Dark-side Digital Acquisition and Digital Piracy Behavior
  - Dr. Monika Kukar-Kinney *(University of Richmond Robins School of Business)*
  - Dr. Mateja Kos Koklic *(University of Ljubljana)*
  - Dr. Irena Vida *(University of Ljubljana)*

**E-commerce and shoppers’ evolution post-Covid19**

- Dr. Zahy Ramadan *(Lebanese American University)*
- Dr. Maya Farah *(Lebanese American University)*
- Ms. Alaa Sleiman *(Lebanese American University)*

### 2pm

**Oral: Consumer Behavior Track - Session 4**

**Behavioral Outcomes in the Sharing and Caring Economy**

*Stage - Stage 5*

Chaired by: Prof. Nicole Hess
### TRUST, SATISFACTION, LOYALTY AND INTENTIONS IN THE SHARING ECONOMY: RESEARCH PROPOSITIONS

» Ms. Lu Yu (Wayne State University), Ms. Archana Mannem (Wayne State University), Dr. Attila Yaprak (Wayne State University)

### Why Not Set Pen to Paper? How Typeface Design Influence Charitable Behaviors

» Dr. Xing-Yu (Marcos) Chu (Nanjing University), Mr. Dickson Tok (Nanjing University), Mr. Junjie Gui (Nanjing University)

### A TEMPORAL PERSPECTIVE OF FOOD WASTE REDUCTION BEHAVIOR

» Dr. Marwa Gad Mohsen (University of Buckingham), Dr. Lubna Nafees (Appalachian State University)

### Psychologically Accessing Ownership: How Does Psychological Ownership Affect Peer-to-Peer Access-Based Consumption?

» Mr. Otávio Teixeira (University of Brasilia)

### 2pm

**Oral:** Marketing Analytics, AI, Machine Learning Track - Session 2

**Understanding the human-Machine Interactions**

*Stage - Stage 6*

Chaired by: Ms. Stella Tavallaei

### Will We Help Others in a Smart City? The Impact of AI Surveillance on Citizens’ Sociability

» Mrs. Emanuela Stagno (BI Norwegian Business School), Dr. Matilda Dorotic (BI Norwegian Business School), Prof. Luk Warlop (BI Norwegian Business School)

### Who resists algorithmic advice?: Cognitive style correlates with algorithmic aversion

» Ms. Heather Yang (MIT Sloan School of Management), Dr. Renée Gosline (MIT Sloan School of Management)

### Keypoints of message design for voice shopping interactions

» Ms. Lea Sollfrank (Goethe University Frankfurt), Dr. Ju-Young Kim (Goethe University Frankfurt)

### 3:15pm

**Workshop**

**Speaker Set Up**

*Stage - SAGE Publishing Stage*

**Stage - SIG Programming and Special Session Stage**

**Stage - EBSCO Stage**

**Stage - Stage 4**

**Stage - Stage 5**

**Stage - Stage 6**
INFLUENCER EQUITY: DEFINITION AND VALUE-CREATION MECHANISMS
» Dr. Essi Pöyry (University of Helsinki), Dr. Petri Parvinen (University of Helsinki)

Effect of Cultural Distances on Online Reviews
» Mr. Rahul Srinivasan (Indian Institute of Management Udaipur), Prof. Prakash Satyavageeswaran (Indian Institute of Management Udaipur), Dr. Sundar Bharadwaj (University of Georgia)

Price Reactions to a Rival’s Market Exit: Evidence from the U.S. Airline Industry
» Dr. Amir Javadinia (Florida Atlantic University), Dr. Sina Aghaie (Wichita State University), Dr. Milad Darani (Kent State University)

Brief Decision Science Intervention for Changing Negative Attitudes Toward Opioid Agonist Treatment: Results from a Pilot Study in Ukraine
» Dr. Maxim Polonsky (Yale University)

THE SPECTER OF DEATH AND THE DESIRE TO COMPETE: THE INFLUENCE OF MORTALITY SALIENCE DUE TO COVID ON THE EVALUATION OF EXCLUSIVE LUXURIES.
» Dr. Nabanita Talukdar (Hult International Business School, San Francisco), Dr. Shubin Yu (HSBC Business School, Peking University, Shenzhen)

The Social Density and Consumer’s Purchase Intention after the COVID-19 Pandemic
» Dr. Yong Wang (Beijing Technology and Business University), Ms. Xue Gu (Beijing Technology and Business University), Dr. Yang Li (Beijing Technology and Business University)

Effectiveness of Price Adjustment and the Influence of Information Acquisition Cost
» Mrs. Emma Wang (University of Edinburgh), Prof. Jake Ansell (University of Edinburgh), Dr. Kirsten Cowan (University of Edinburgh)

Pop-Up Stores: How They Drive Online Sales and the Moderation Effects of Other Promotion Tools
» Prof. Shuai Yang (Donghua University), Mr. Junjie Wang (Donghua University), Prof. Hualu Zheng (Susquehanna University), Ms. Yahui Liu (Donghua University)
UNDERSTANDING THE VARIOUS WAYS CONSUMERS COPE WITH A PANDEMIC CRISIS-A QUALITATIVE APPROACH
» Dr. Melika Kordrostami (California State University, San Bernardino), Dr. Elika Kordrostami (Rowan University)

The Role of External Cues on Consumer Adoption of Cannabidiol (CBD) Products: A Health Belief Model Approach
» Dr. Laee Choi (Colorado State University-Pueblo), Dr. Jiyoung Hwang (The University of North Carolina at Greensboro), Dr. Sanghyuck Park (Colorado State University-Pueblo)

3:30pm Oral: B2B Marketing, Supply Chain Management and Sales Management Track - Session 2
Micro issues in sales force management and personal selling
Stage - Stage 5
Chaired by: Dr. Reza Rajabi

Moral judgement in business negotiation: Personality, society, or self-interest
» Dr. Eran Rubin (University of Akron), Dr. Frederik Beuk (University of Akron)

Advancing B2B Social Selling: The relevancy of post personality
» Dr. Roberto Mora Cortez (Southern Denmark University), Mr. Ayan Ghosh Dastidar (Georgia State University)

Control and Justice Perceptions: Multiple Controls and Crowding Out Effects
» Dr. Reza Rajabi (Northern Illinois University), Dr. Tiffany Legendre (University of Massachusetts, Amherst), Fundacao Getulio Vargas

A Comprehensive Examination of Salesforce Satisfaction and Performance
» Ms. Claire Cha (University of Massachusetts), Dr. Reza Rajabi (Northern Illinois University), Mr. Hossein Hashemi (University of Massachusetts), Dr. Thomas Brashear Alejandro (University of Massachusetts, Amherst)

3:30pm Oral: International & Cross-Cultural Marketing Track - Session 2
International Marketing Strategies
Stage - Stage 6
Chaired by: Mr. Kiwoong Yoo

The influence of language on attitudes toward brands
» Mr. David DeFranza (University of Utah), Dr. Aurl Mishra (University of Utah), Dr. Himanshu Mishra (University of Utah)

» Mrs. Marina Kovalchuk (University of Eastern Finland), Prof. Mika Gabrielsson (University of Eastern Finland), Prof. Andreas Fürst (Friedrich-Alexander University Erlangen-Nürnberg)

Why Not Both? Utilizing Knowledge Management Capability for Market Exploration and Exploitation Among Mexican Firms
» Mr. Jacob Almaguer (University of Texas Rio Grande Valley), Dr. Edith Galy (University of Texas Rio Grande Valley)

The Impact of Disruptions in Global Trade Agreements on Multinational Firms’ Use of International Strategic Alliances
» Mr. Kiwoong Yoo (Marketing Doctoral Candidate, University of Tennessee - Knoxville), Dr. Kelly Hewett (University of Tennessee - Knoxville), Dr. Satish Jayachandran (University of South Carolina), Dr. Alexander Krasnikov (Loyola University Chicago)

5pm General Marketing Research SIG Reception
Stage - SAGE Publishing Stage
## 2021 AMA Summer Academic Conference

**04 - 06 Aug 2021 All times in CDT**

### Thursday, 5 August

<table>
<thead>
<tr>
<th>Time</th>
<th>Event</th>
</tr>
</thead>
<tbody>
<tr>
<td>5pm</td>
<td><strong>Marketing Research SIG Reception</strong></td>
</tr>
<tr>
<td></td>
<td>» P. K. Kannan, Praveen Kopalle</td>
</tr>
<tr>
<td></td>
<td><strong>RAPSIG Reception</strong></td>
</tr>
<tr>
<td></td>
<td>» Stephanie Noble, Abhijit Guha, Courtney Szocs</td>
</tr>
</tbody>
</table>

### Friday, 6 August

<table>
<thead>
<tr>
<th>Time</th>
<th>Event</th>
</tr>
</thead>
<tbody>
<tr>
<td>7:45am</td>
<td><strong>Workshop</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Speaker Set Up</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Stage - SIG Programming and Special Session Stage</strong></td>
</tr>
<tr>
<td>7:45am</td>
<td><strong>Workshop</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Speaker Set Up</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Stage - SIG Programming and Special Session Stage</strong></td>
</tr>
<tr>
<td>7:45am</td>
<td><strong>Workshop</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Speaker Set Up</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Stage - EBSCO Stage</strong></td>
</tr>
<tr>
<td>7:45am</td>
<td><strong>Workshop</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Speaker Set Up</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Stage - EBSCO Stage</strong></td>
</tr>
</tbody>
</table>

**Powered by Ex Ordo, your online conference platform.**
Continued from Friday, 6 August

8am
Workshop: Inspirational - Privacy Research in Marketing
Privacy Research in Marketing as Social Responsibility
Stage - EBSCO Stage
Chaired by: Prof. Kelly Martin and Dr. Kristen Walker

Privacy Research in Marketing as Social Responsibility
» Prof. Kelly Martin (Colorado State University), Dr. Kristen Walker (California State University, Northridge)

8am
Workshop: Research Design
Theory Construction
Stage - Stage 4
Chaired by: Prof. Ajay Kohli

Theory Construction
» Prof. Ajay Kohli (Georgia Institute of Technology)

8am
Workshop: Skills - Text Mining Methods
Text Mining Methods and Applications: Automated Text Analysis
Stage - Stage 5
Chaired by: Prof. Ashlee Humphreys

Text Mining Methods and Applications: Automated Text Analysis
» Prof. Ashlee Humphreys (Northwestern University)

9am
Workshop
Speaker Set Up
Stage - Plenary Stage

9:30am Keynote
AI-Human Interactions: Bridging the Gap Between Policy Makers, Academia and Business
Stage - Plenary Stage
Chaired by: Dr. Matilda Dorotic

AI-Human Interactions: Bridging the Gap Between Policy Makers, Academia and Business
» Mr. Irakli Beridze (Head of the Centre for Artificial Intelligence and Robotics at UNICRI), Dr. Cansu Canca (AI Ethics Lab), Mr. Lofred Madzou (Project Lead for AI at the World Economic Forum), Dr. Koen Pauwels (Northwestern University), Mr. Graham Porter (Dell Technologies Alliances), Prof. Andrew Stephen (Saïd Business School, University of Oxford), Dr. Matilda Dorotic (BI Norwegian Business School)

10:45am Workshop
Speaker Set Up
Stage - SAGE Publishing Stage

10:45am Workshop
Speaker Set Up
Stage - SIG Programming and Special Session Stage

10:45am Workshop
Speaker Set Up
Stage - EBSCO Stage

10:45am Workshop
Speaker Set Up
Stage - Stage 4
### 2021 AMA Summer Academic Conference 04 - 06 Aug 2021 All times in CDT

**Continued from** Friday, 6 August

<table>
<thead>
<tr>
<th>Time</th>
<th>Event</th>
<th>Location</th>
<th>Chaired by</th>
</tr>
</thead>
<tbody>
<tr>
<td>10:45am</td>
<td><strong>Workshop</strong> Speaker Set Up</td>
<td>Stage - Stage 5</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Workshop</strong> Speaker Set Up</td>
<td>Stage - Stage 6</td>
<td></td>
</tr>
<tr>
<td>11am</td>
<td><strong>General</strong> AMA-EBSCO-RRBM AWARDS SESSION</td>
<td>Stage - SAGE Publishing Stage</td>
<td>Dr. Samantha N. N. Cross</td>
</tr>
<tr>
<td></td>
<td><strong>General</strong> Pop-Up SIG: Sustainability Marketing</td>
<td>Stage - SIG Programming and Special Session Stage</td>
<td>Matthew Lunde</td>
</tr>
<tr>
<td></td>
<td><strong>General</strong> Reinvigorating the Study of Brand Charisma</td>
<td>Stage - EBSCO Stage</td>
<td>Prof. Carlos Torelli and Prof. Maria Rodas Waters</td>
</tr>
</tbody>
</table>

### Keynotes

- **‘Rebecca. Always Rebecca’: Understanding Dimensions of a Charismatic Novel.**
  - Prof. Cele Otnes (University of Illinois Urbana-Champaign), Prof. Pauline Maclaran (Royal), Prof. Robin Canniford (University of Melbourne)

- **The Negative Potential of Charismatic Brands: James Bond Fandom and Negative Nostalgia**
  - Prof. Chloe Preece (Royal Holloway, University of London), Prof. Finola Kerrigan (University of the Arts London)

- **Charismatic CEOs: How Powerful People with Charismatic Professional Brands Can Drive Markets**
  - Prof. Pierre-Yann Dolbec (Concordia University), Prof. Eileen Fischer (York University)

### Oral Sessions

- **Oral : Services, Retailing, and Customer Experience Track - Session 3 Consumption and Emerging Technologies**
  - **Customer Experience with Augmented Reality Technology in Retailing: (In)authentic Self and Reality versus Curiosity and Fun**
    - Mr. Khaled El Shamandi Ahmed (Henley Business School, University of Reading)

- **The Impact of Value Congruence and Social Interaction between Founder and Backers on Intention to Invest**
  - Prof. Tien Wang (Institute of International Management, National Cheng Kung University), Ms. Susan Chrestella Bahari, Dr. Trung Dam-Huy Thai (Institute of International Management, National Cheng Kung University)
Investigating the Willingness to Pay for Enhanced Mobile Internet Services: Evidence from A Mobile Network Upgrade
» Mr. Yi Zhu (University of Minnesota - Twin Cities), Dr. Jason Chan (University of Minnesota - Twin Cities), Dr. Xuan Bi (University of Minnesota - Twin Cities), Dr. Yue Guo (Southern University of Science and Technology), Dr. Jun Wu (Beijing University of Posts and Telecommunications)

Impacts of Perceived Robot Eeriness on Future Approach Intentions of Third-party Observers
» Mr. Ross Murray (The University of Texas Rio Grande Valley), Dr. Xiaojing Sheng (The University of Texas Rio Grande Valley), Dr. Reto Felix (The University of Texas Rio Grande Valley)

Social Media Influencers: Their Impact on Consumers, Firms, and Taboo Topics
Stage - Stage 5
Chaired by: Dr. Marcos Almeida

#INFERTILITY – Dealing with Taboo Topics on Social Media
» Ms. Jana Grothaus (TU Dortmund), Dr. Sarah Koecher (TU Dortmund), Dr. Sören Koecher (TU Dortmund), Prof. Hartmut H. Holzmueller (TU Dortmund)

Unpacking the concept of influencers: the moderating role of Social Media Influencers in service failure recovery strategies
» Prof. Wilson Ozuem (University of Cumbria), Prof. Silvia Ranfagni (University of Florence), Ms. Michelle Willis (University of Cumbria), Prof. Serena Rovai (Excelia Business School)

Let's Get Digital: An Exploratory Study of the Impact of Influencers on Digital Wellness
» Ms. Ashley Hass (Texas Tech University), Dr. Debra A. Laverie (Texas Tech University)

Candidate sentiment, traditional, owned and earned social media: the role of fan following in influencing voting intentions
» Dr. Marcos Almeida (Federal University of Goiás), Dr. Luiz Paulo Fávero (University of São Paulo), Dr. Valter Vieira (State University of Maringá), Ms. Rafael de Freitas Souza (University of São Paulo)

How YouTube Health Vloggers Influence Viewer Compliance: The Interplay Between Vlogger Characteristics, Parasocial Interaction, and Viewer Characteristics
» Dr. Md Nazmus Sakib (McNeese State University), Dr. MD Al-Emran (McNeese State University)

The Measurement of Brand Activism: Scale Development and Validation
» Ms. Nuket Serin (FL), Dr. Jayati Sinha (Florida International University)

Consumer’s perceptions towards a luxury brand: a comparative evaluation between brand love and brand engagement
» Prof. Paula Rodrigues (Universidade Lusíada - Norte, COMEGI Research Center), Dr. Ana Sousa (Universidade Lusíada - Norte, COMEGI Research Center), Ms. Catarina Correia (Universidade Lusíada - Norte, COMEGI Research Center)

The Impact of University Location and Ranking on Brand Name and Logo of Cross-Country Higher Education Alliance in China
» Prof. Jiaxun He (East China Normal University), Dr. Mingyue Zhang (East China Normal University), Ms. Qian Zhang (East China Normal University), Ms. Jingxian Wu (East China Normal University)

Brand Structure and Extension Typicality Effects on the Diagnosticity of Negative Extension Information
» Prof. Joseph Chang (University of Massachusetts Dartmouth)
<table>
<thead>
<tr>
<th>Time</th>
<th>Event</th>
</tr>
</thead>
<tbody>
<tr>
<td>12:15pm</td>
<td><strong>Workshop</strong></td>
</tr>
<tr>
<td></td>
<td>Speaker Set Up</td>
</tr>
<tr>
<td></td>
<td>Stage - SAGE Publishing Stage</td>
</tr>
<tr>
<td>12:15pm</td>
<td><strong>Workshop</strong></td>
</tr>
<tr>
<td></td>
<td>Speaker Set Up</td>
</tr>
<tr>
<td></td>
<td>Stage - SIG Programming and Special Session Stage</td>
</tr>
<tr>
<td>12:15pm</td>
<td><strong>Workshop</strong></td>
</tr>
<tr>
<td></td>
<td>Speaker Set Up</td>
</tr>
<tr>
<td></td>
<td>Stage - EBSCO Stage</td>
</tr>
<tr>
<td>12:15pm</td>
<td><strong>Workshop</strong></td>
</tr>
<tr>
<td></td>
<td>Speaker Set Up</td>
</tr>
<tr>
<td></td>
<td>Stage - Stage 6</td>
</tr>
<tr>
<td>12:30pm</td>
<td><strong>General</strong></td>
</tr>
<tr>
<td></td>
<td>AMA Meet the Editors Part 2 - Topics</td>
</tr>
<tr>
<td></td>
<td>Stage - SAGE Publishing Stage</td>
</tr>
<tr>
<td></td>
<td>Chaired by: Dr. Koen Pauwels</td>
</tr>
<tr>
<td>12:30pm</td>
<td><strong>General</strong></td>
</tr>
<tr>
<td></td>
<td>SALESSIG: Managerial Interventions for Enablement of Salespeople's</td>
</tr>
<tr>
<td></td>
<td>Approaches and Activities</td>
</tr>
<tr>
<td></td>
<td>Stage - SIG Programming and Special Session Stage</td>
</tr>
<tr>
<td></td>
<td>Chaired by: Mr. Khashayar Afshar Bakeshloo and Dr. Ashley Goreczny</td>
</tr>
<tr>
<td></td>
<td>and Dr. Stephanie Mangus and Dr. Huanhuan Shi and Dr. Amin Rostami</td>
</tr>
<tr>
<td>12:30pm</td>
<td><strong>General</strong></td>
</tr>
<tr>
<td></td>
<td>Consumer Behavior amidst and beyond the COVID-19 Pandemic</td>
</tr>
<tr>
<td></td>
<td>Stage - EBSCO Stage</td>
</tr>
<tr>
<td></td>
<td>Chaired by: Dr. Alexis Yim and Ms. Yumei Mu and Ms. Yuerong Liu and</td>
</tr>
<tr>
<td></td>
<td>Mr. Liguo Liu and Ms. Elizabeth Gratz and Mr. Vijay Bharti</td>
</tr>
</tbody>
</table>
Continued from Friday, 6 August

Consumer Behavior amidst and beyond the COVID-19 Pandemic
» Dr. Annie Cui (West Virginia University), Dr. Jody Crosno (West Virginia University), Dr. Stephen He (West Virginia University), Dr. Julian Givi (West Virginia University), Dr. Paula Fitzgerald (West Virginia University), Dr. Alexis Yim (Radford University), Ms. Yumei Mu (West Virginia University), Ms. Yuering Liu (West Virginia University), Mr. Liguo Liu (West Virginia University), Ms. Elizabeth Gratz (West Virginia University), Mr. Vijay Bharti (West Virginia University)

12:30pm Oral: Services, Retailing, and Customer Experience Track - Session 4
Customer Decision-Making and Pricing
Stage - Stage 4
Chaired by: Ms. Alisa Keller

Spillover of Product Engagement in Add-ons: Side Effects of Network Homogeneity
» Mr. Pallav Routh (University of Texas at San Antonio), Dr. Richard Gretz (University of Texas at San Antonio), Dr. Daniel Kaimann (Paderborn University)

‘Did I make the right choice?’ - Suggestions for Reducing Cognitive Dissonance in a High-Credence Service - the Case of Higher Education
» Dr. Andreas Zehetner (University of Applied Sciences Upper Austria)

Investigating the competition between price and valence of online ratings to influence consumers’ perception of product quality
» Mr. Mohammadali Koorang Beheshti (Old dominion university), Dr. Yuping Liu-Thompkins (Old dominion university), Mr. Mehdi Koorang Beheshti (Amirkabir University)

CLICK-AND-COLLECT WITH IMPULSE BUYING: PRICING DECISIONS AND THE CHOICE OF PICKUP STATION
» Prof. Chyi-Mei Chen (Department of Finance, National Taiwan University), Prof. Shan-Yu Chou (Department of Business Administration, National Taiwan University)

12:30pm Oral: Marketing Strategy Track - Session 1
Role of Marketing in Adversities
Stage - Stage 5
Chaired by: Mr. Kohei Matsumoto

The Effect of Product Recall by Competitors on Innovation
» Mr. Kohei Matsumoto (University of Illinois at Chicago), Prof. Anna Shaojie Cui (University of Illinois at Chicago), Prof. Alan J. Malter (University of Illinois at Chicago)

Scandals and strategic alliances: Spillover effect on partners
» Mr. Dimitri Simonin (University of Technology Sydney), Dr. Jan Hohberger (Esade Business School)

The Dark Side of Marketing: An Empirical Examination of Marketing’s Role in the Opioid Epidemic
» Ms. Rachel Ramey (University of Georgia), Dr. Sundar Bharadwaj (University of Georgia)

When Do Business Buyers Offer Suppliers a “Second Chance” After Being Betrayed? The Moderating Role of Emotions of Business Buyers in Betrayal Incidents
» Dr. Noelle Chung (NEOMA Business School), Dr. Kyungwon Lee (University of Michigan-Dearborn)

12:30pm Oral: Services, Retailing, and Customer Experience Track - Session 6
Social Responsibility
Stage - Stage 6

MULTICULTURAL READINESS IN SERVICE ECOSYSTEMS
» Mrs. Zahra Daneshfar (Curtin University), Prof. Piyush Sharma (Curtin University), Dr. Russel Kingshott (Curtin University)
A Meta-Analytic Review of The Impact of Service Leadership on Customer-Related Outcomes
» Dr. Kristina Lindsey Hall (Louisiana State University), Dr. Ji Qi (Grand Valley State University), Dr. Harrison Pugh (The University of North Carolina, Greensboro), Dr. Eric Michel (Northern Illinois University), Ms. Brittany Buis (University of Illinois at Chicago), Dr. Darren Good (Pepperdine University), Dr. Matthew Leon (University of North Florida)

Antecedents to Emotional Motivators for Green Consumption Behavior
» Dr. Birgit Leisen Pollack (University of Wisconsin Oshkosh)

Mixed Signals? Consumer Responses to Price Image and Corporate Social Responsibility
» Ms. Eileen Dauti (University of Passau), Prof. Dirk Totzek (University of Passau)

1:45pm Workshop
Speaker Set Up
Stage - Stage 6

2pm General
SalesSIG Special Session - Enabling Sales in a Globally Transformed World: Challenges & Opportunities for Sales Enablement
Stage - SIG Programming and Special Session Stage

SalesSIG Special Session - Enabling Sales in a Globally Transformed World: Challenges & Opportunities for Sales Enablement
» Joel Le Bon, Ellen Pullins, Stephanie Mangus

2pm General
Business School Curriculum Innovation and Sustainability Organized by SAGE Publishing
Stage - EBSCO Stage
Chaired by: Prof. Bodo Schlegelmilch and Prof. Victoria Crittenden and Prof. Mark Peterson

1:45pm Workshop
Speaker Set Up
Stage - Stage 4

2pm Oral: B2B Marketing, Supply Chain Management and Sales Management Track - Session 3
Revisiting established frameworks and theories of interorganizational relationships
Stage - Stage 4
Chaired by: Dr. Tiffany Legendre

Digitization of Interorganizational Relationships: Direct Effects of Benefit Magnitude and Indirect Effects of Benefit Asymmetry on Reseller Profit
» Dr. Talai Osmonbekov (Northern Arizona University), Dr. Brian Gregory (Northern Arizona University)
2pm | Oral : Marketing Strategy Track - Session 3
Marketing in Upper Echelons
Stage - Stage 5
Chaired by: Mr. Youngtak Kim

A Narcissistic CEO in Times of Turbulence - Is it Desirable for a Firm's Reputation?
» Mr. Jan Bredlich (Innovation and Entrepreneurship Group (WIN) – TIME Research Area, RWTH Aachen University, Kackertstr. 7, 52072 Aachen, Germany; tel: +49 241 80 96359), Mr. Sebastian Kruse (Innovation and Entrepreneurship Group (WIN) – TIME Research Area, RWTH Aachen University, Kackertstr. 7, 52072 Aachen, Germany; tel: +49 241 80 96359)

Using Computer-Aided Text Analysis to Investigate Contingencies of Market Orientation and Entrepreneurial Orientation Effects on Firm Financial Performance
» Mr. Philip Wagner (Justus-Liebig-University Giessen), Dr. Stephan Volpers (Justus-Liebig University Giessen), Dr. Alexander Haas (Justus-Liebig-University Giessen)

2021 AMA Summer Academic Conference 04 - 06 Aug 2021 All times in CDT

Continued from Friday, 6 August

Franchisee Opportunism – An Emerging Market Perspective
» Dr. Swati Panda (Kennesaw State University), Dr. Satyendra Pandey (Institute of Rural Management), Dr. Audhes Paswan (University of North Texas), Dr. Lou Pelton (University of North Texas)

» Ms. Jessica Felix (THE UNIVERSITY OF TEXAS AT EL PASO), Dr. Fernando R. Jimenez (THE UNIVERSITY OF TEXAS AT EL PASO), Dr. Miguel A. Ramos (THE UNIVERSITY OF TEXAS AT EL PASO)

» Dr. Saeed Shekari (William Paterson University), Dr. Bahar Ashnai (William Paterson University)

2pm

Oral : Services, Retailing, and Customer Experience - Session 4
COVID and Consumption
Stage - Stage 6
Chaired by: Dr. Francesca Bonetti

The Role of Time in Customer Reactions for Scarcity Appeals
» Dr. Sungkyu Lee (Akita International University), Dr. Woo Li Ko (Musashino University)

HOW CUSTOMER ENGAGEMENT AND SOCIAL DISTANCE CONCEPTUALIZE IN THE “CGBP-SQ MODEL”
» Mr. Hamed Azad (UON)

The impact of COVID-19 on cleaning surcharges in the hospitality accommodations
» Mr. Saeed Zal (Old dominion university), Mr. Mohammadali Koorank Beheshi (Old dominion university), Dr. Kristina Harrison (The University of Southern Mississippi)

Investigating shopper value calculus during COVID-10; A replication study
» Mr. Ashish Kakar (Texas Tech University)
Continued from Friday, 6 August

GRAPPLING WITH CHANGE: STRATEGIC RESPONSES TO THE CHALLENGES OF IMPLEMENTING CONSUMER-FACING IN-STORE TECHNOLOGY IN FASHION RETAIL

» Dr. Francesca Bonetti (London College of Fashion), Dr. Patsy Perry (Manchester Metropolitan University)

<table>
<thead>
<tr>
<th>Time</th>
<th>Session</th>
<th>Chaired by</th>
</tr>
</thead>
<tbody>
<tr>
<td>3:30pm</td>
<td><strong>General</strong> Relationship Marketing SIG Reception <strong>Stage - SAGE Publishing Stage</strong></td>
<td>*AMA Foundation</td>
</tr>
<tr>
<td></td>
<td><strong>Representations Matters: Celebrating Scholars of Color in the Classroom</strong></td>
<td>Prof. Maura Scott and Prof. Nicole Ann Davis and Prof. Shawn Enriques</td>
</tr>
<tr>
<td>3:30pm</td>
<td><strong>General</strong> SalesSIG Reception <strong>Stage - SIG Programming and Special Session Stage</strong></td>
<td><em>SALESSIG: Enabling Sales in a Globally Transformed World: Challenges &amp; Opportunities for Sales Enablement</em> Dr. Stephanie Mangus and Joel Le Bon</td>
</tr>
<tr>
<td></td>
<td><strong>Pop-Up SIG: Sustainability Marketing</strong></td>
<td>Matthew Lunde</td>
</tr>
<tr>
<td>3:30pm</td>
<td><strong>General</strong> Entrepreneurial Marketing SIG Reception <strong>Stage - EBSCO Stage</strong></td>
<td><em>RM SIG Special Session: Editorial Perspectives on Relationship Marketing Research</em> Hui Feng and Alok Saboo and Naveen Donthu and Dr. Kelly Hewett and JOHN HULLAND and Prof. Werner Reinartz</td>
</tr>
<tr>
<td></td>
<td><strong>SERVSIG: The Edge of Tomorrow: How AI Shapes the Future of Service Research</strong></td>
<td>Prof. Arne De Keyser and Prof. Dominik Mahr and Prof. Chiara Orsingher and Prof. Florian von Wangenheim</td>
</tr>
</tbody>
</table>

On Demand

<table>
<thead>
<tr>
<th>Date</th>
<th>Session</th>
<th>Chaired by</th>
</tr>
</thead>
<tbody>
<tr>
<td>23 July</td>
<td><strong>Bundle: 2 Sessions released on-demand</strong> <strong>AMA Foundation Sessions</strong></td>
<td><em>AMA Foundation Sessions</em></td>
</tr>
<tr>
<td>9am</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Powered by [Ex Ordo](https://exordo.com), your online conference platform.
<table>
<thead>
<tr>
<th>Page 28</th>
<th>Workshop: Skills - Text Mining Methods</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Text Mining Methods and Applications: Automated Text Analysis</td>
</tr>
<tr>
<td></td>
<td>Chaired by: Prof. Ashlee Humphreys</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Page 29</th>
<th>Workshop: Research Design</th>
</tr>
</thead>
<tbody>
<tr>
<td>2 of 13</td>
<td>Theory Construction</td>
</tr>
<tr>
<td></td>
<td>Chaired by: Prof. Ajay Kohli</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Page 30</th>
<th>Workshop: Inspirational - Privacy Research in Marketing</th>
</tr>
</thead>
<tbody>
<tr>
<td>3 of 13</td>
<td>Privacy Research in Marketing as Social Responsibility</td>
</tr>
<tr>
<td></td>
<td>Chaired by: Prof. Kelly Martin and Dr. Kristen Walker</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Page 31</th>
<th>Workshop: Inspirational - Opportunities and Challenges in B2B</th>
</tr>
</thead>
<tbody>
<tr>
<td>4 of 13</td>
<td>Opportunities and Challenges in B2B Marketing</td>
</tr>
<tr>
<td></td>
<td>Chaired by: Prof. Stefan Wuyts and Prof. Kenneth Wathne and Prof. Erik Mool and Prof. Rajdeep Grewal</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Page 32</th>
<th>Workshop: Skills - Machine Learning/AI for Marketing</th>
</tr>
</thead>
<tbody>
<tr>
<td>5 of 13</td>
<td>Machine Learning/AI for Marketing: Personalize Customer Engagement with the AI</td>
</tr>
<tr>
<td></td>
<td>Chaired by: Prof. Rajkumar Venkatesan</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Page 33</th>
<th>Workshop: Skills - Addressing Endogeneity Part 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>6 of 13</td>
<td>Addressing endogeneity Part 2: Advanced approaches in addressing endogeneity</td>
</tr>
<tr>
<td></td>
<td>Chaired by: Prof. Dominik Papes and Prof. Peter Ebbes</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Page 34</th>
<th>Workshop: Responsible Research</th>
</tr>
</thead>
<tbody>
<tr>
<td>7 of 13</td>
<td>Responsible Research: Marketplace Access, Equity, and Power</td>
</tr>
<tr>
<td></td>
<td>Chaired by: Prof. Sterling Bone</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Page 35</th>
<th>Workshop: Experimental Methods</th>
</tr>
</thead>
<tbody>
<tr>
<td>8 of 13</td>
<td>Experimental methods: Social media field experiments</td>
</tr>
<tr>
<td></td>
<td>Chaired by: Prof. David Rand</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Page 36</th>
<th>Workshop: Writing</th>
</tr>
</thead>
<tbody>
<tr>
<td>9 of 13</td>
<td>How to craft a great manuscript for publication?</td>
</tr>
<tr>
<td></td>
<td>Chaired by: Prof. Werner Reinartz</td>
</tr>
</tbody>
</table>
## 2021 AMA Summer Academic Conference

**04 - 06 Aug 2021** *All times in CDT*

<table>
<thead>
<tr>
<th>10 of 13</th>
<th><strong>Workshop: Skills - Addressing Endogeneity Part 1</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Addressing endogeneity Part 1: Causality, endogeneity, and econometric approaches</td>
</tr>
<tr>
<td></td>
<td>Chaired by: Prof. Peter Ebbes and Prof. Dominik Papies</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>11 of 13</th>
<th><strong>Workshop: Career</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Making the Transition from Academia to Industry</td>
</tr>
<tr>
<td></td>
<td>Chaired by: Mr. Isaac Dinner and Ms. Annie Wilson</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>12 of 13</th>
<th><strong>Workshop: Skills - Casual Inference</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Causal Inference</td>
</tr>
<tr>
<td></td>
<td>Chaired by: Prof. Kathy Li</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>13 of 13</th>
<th><strong>Workshop: Teaching</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Conducting Engaging Synchronous Online Courses</td>
</tr>
<tr>
<td></td>
<td>Chaired by: Prof. Timothy Keiningham</td>
</tr>
</tbody>
</table>

### 1 August

**9am**

**Bundle: 2 Sessions released on-demand**

**AMA Sponsors and Innovation Showcase**

**1 of 2**

**General**

**AMA Sponsors**

**2 of 2**

**Keynote**

**Innovation Session**

### 2 August

**9am**

**Bundle: 8 Sessions released on-demand**

**Posters**

**1 of 8**

**Poster**

**Posters: B2B Marketing, Supply Chain Management and Sales Management Track**

**2 of 8**

**Poster**

**Posters: Branding, Innovation and the 4Ps Track**

### 2 August

**Bundle: 6 Sessions released on-demand**

**AMA Journal Sessions**

**1 of 6**

**General**

**JOURNAL OF INTERNATIONAL MARKETING AWARDS SESSION | S. Tamer Cavusgil Award and Hans B. Thorelli Award**

**Chaired by: Kelly Hewett**

**2 of 6**

**General**

**JOURNAL OF MARKETING AWARDS SESSION: AMA/MSI/ROOT WINNER**

**Chaired by: Page Moreau**

**3 of 6**

**General**

**Journal of Marketing Award Session: Sheth Foundation/JM Award & Shelby D. Hunt/Harold H. Maynard Award**

**Chaired by: Robert Palmatier and Harald Van Heerde**
| Page 33 |

<table>
<thead>
<tr>
<th>General</th>
<th>JOURNAL OF PUBLIC POLICY &amp; MARKETING AWARDS SESSION</th>
<th>Thomas C. Kinnear/ Journal of Public Policy &amp; Marketing Award</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Chaired by: Kelly Martin and Maura Scott</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>General</th>
<th>JOURNAL OF MARKETING RESEARCH AWARDS SESSION</th>
<th>PAUL E. GREEN AWARD</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Chaired by: Dr. Vikas Mittal</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>General</th>
<th>JOURNAL OF MARKETING RESEARCH AWARDS SESSION</th>
<th>WEITZ WINER O'DELL AWARD</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Chaired by: Dr. Peter Danaher</td>
<td></td>
</tr>
</tbody>
</table>
The Role of Anthropomorphism in Customer-Robot Interaction

Authors
Dr. Rae Yule Kim - Montclair State University

Direct-to-Consumer Advertising in the Pharmaceutical Industry

Authors
Ms. Giana Cofman - Emmanuel College
Dr. Jing Yang - Emmanuel College

Can sport serve as a platform for pro-environmental behavior with political conservatives? An examination of college sport sustainability efforts

Authors
Dr. Jonathan Casper - North Carolina State University
Dr. Brian McCullough - Texas A&M University
Mrs. Danielle Smith - University of North Carolina Chapel Hill
How customer self-determination regulates customers’ anger and revenge behavior

Authors
Dr. Mina Rohani - Saint Mary’s College of California
Dr. Nasser Shahrasbi - San Francisco State University
Dr. Mostafa Purmehdi - University of the Fraser Valley

Solving the Paradox of a Large Assortment: The Moderating Role of Choice Mode

Authors
Ms. Mikyoung Lim - University of South Florida
Prof. Young-Won Ha - The State University of New York Korea

Thirty Years of AI Research in Marketing: A Bibliometric Analysis

Authors
Mr. William Shiue - King’s College London
Dr. Aybars Tuncdogan - King’s College London
Mr. Ismail Cagri Dogan - Ankara Yildirim Beyazit University
Prof. Stuart Barnes - King's College London
Relational Justice and Optimal Compensation in Service Recovery. Does Failure Severity Matter?

Authors
Dr. Nayyer Naseem - Northeastern State University
Dr. Attila Yaprak - Wayne State University

The Consummate Consumer

Authors
Dr. Parimal Bhagat - Indiana University of Pennsylvania

Impacts of Face Coverings, Background Noise, Perceived Customer Attractiveness, and Intelligibility of Speech on Frontline Employee Job Stress

Authors
Mr. Ross Murray - The University of Texas Rio Grande Valley
Dr. Xiaojing Sheng - The University of Texas Rio Grande Valley
Dr. Michael Minor - university of texas rio grande va
The Power of the Networking Consumer: Analyzing the Egyptian “Let it Rust” Campaign on Facebook from a Consumer Empowerment Perspective

Authors
Ms. Sara Khater - Faculty of Mass Communication, Cairo University
Dr. Dina Orabi - Galala University

Bad News Is Not Always Worse than No News: A Moderated Mediation Model of Source of Corporate Social Irresponsibility Information and Perceived Intrinsic Motives

Authors
Dr. Chi-Cheng Luan - National Yang Ming Chiao Tung University
Mr. Su Zhang - National Yang Ming Chiao Tung University
Ms. NGOC ANH PHAM - National Yang Ming Chiao Tung University
Ms. Yanjun Lu - National Yang Ming Chiao Tung University
Mr. Cheng Ying Tsai - National Yang Ming Chiao Tung University
Can celebrity be liable for fans' misbehavior?

Authors
Dr. Li-Keng Cheng - Tatung University
Dr. Chung-Lin Toung - Nanfang College of Sun Yat-Sen University
Ms. Siang-Yi Li - Tatung University
Ms. Chen Pinting - Tatung University

Retailers’ COVID-19 related announcements and their impact on firm value

Authors
Mr. Navid Bahmani - University of Wisconsin-Milwaukee

Do we Trust AI-based services using Chatbots? The role of Anthropomorphic Design

Authors
Mr. Li Kai (Michael) Tseng - Department of Business Administration, National Chengchi University
Prof. Sungjun (Steven) Park - Department of Business Administration, National Chengchi University (NCCU)
Perceived brand globalness and perceived brand localness: A meta-analysis

Authors
Mr. Volkan Kocer - University of Passau

Memes in Advertising as Inauthentic Communication: The Triggering of Persuasion Knowledge in Young Consumers

Authors
Dr. Kenneth Henrie - Pennsylvania State University-Greater Allegheny
Dr. Christian Gilde - University of Montana Western

Brand authenticity in a pandemic context: transparency, proximity and solidarity

Authors
Dr. Amélie Guèvremont - École des Sciences de la Gestion, Université du Québec à Montréal
Ms. Laurence Dubé-Beaudin - École des Sciences de la Gestion, Université du Québec à Montréal
Dr. Fabien Durif - École des Sciences de la Gestion, Université du Québec à Montréal
Teenagers’ self-presentation and brand identification on Instagram: An exploratory study

Authors
Ms. Laurence Dubé-Beaudin - École des Sciences de la Gestion, Université du Québec à Montréal
Dr. Amélie Guèvremont - École des Sciences de la Gestion, Université du Québec à Montréal

Meme Your Brands: The Role of Meme in Consumer Engagement with Brands

Authors
Ms. Sphurti Sewak - Florida International University
Dr. Jaehoon Lee - Florida International University

Gendered Perceptions of Numbers in Alphanumeric Brands

Authors
Ms. Stella Tavallaei - Florida International University
Dr. Omid Kamran Disfani - Southern Illinois University, Carbondale
Playing with Politics - The Relationship between CEO Narcissism and Firm Lobbying Activities

Authors
Mr. Jan Bredlich - Innovation and Entrepreneurship Group (WIN) – TIME Research Area, RWTH Aachen University, Kackertstr. 7, 52072 Aachen, Germany; tel: +49 241 80 96359
Mr. Sebastian Kruse - Innovation and Entrepreneurship Group (WIN) – TIME Research Area, RWTH Aachen University, Kackertstr. 7, 52072 Aachen, Germany; tel: +49 241 80 96359

When Consumers Decrease Ethical Behavior: Resource Scarcity and Ethical Behavior

Authors
Mr. Todd Haderlie - Florida International University
Dr. Jaehoon Lee - Florida International University

Brand perceived social sustainability scale

Authors
Mr. Nagendra S M - IIT Ropar
Dr. Dipanjan Kumar Dey - IIT Ropar
**Warm Glow or Cold Cash: Designing Sales Promotion Tactics for Sustainable Products in E-Commerce**

**Authors**
Ms. Katharina Glaen - RWTH Aachen University
Mr. Sebastian Kruse - RWTH Aachen University

**Gorgeous Low-key or High-toned Luxury: The Role of Social Identity Threat, Symbolism, and Narcissism on The Choice between High- and Low-key Versions of A Luxury Product**

**Authors**
Ms. Xixi Li - Saint Louis University
Prof. Jiang Chuandi - Emporia State University

**Going Green through Psychological Ownership for the Community and Planet Earth**

**Authors**
Dr. Chris Hinsch - Grand Valley State University
Dr. Elina Tang - Northern Illinois University
Dr. Reto Felix - The University of Texas Rio Grande Valley
An Empirical Investigation of Entrepreneurs’ Communication and Gamification Strategies in Crowdfunding

Authors
Mr. June-ho Chung - Rutgers University

The impact of the green attribute and texture on product and personal gender identities

Authors
Ms. Mivena Panteqi - Villanova University
Ms. Corrine Sullivan - Villanova University
Dr. Yoon-Na Cho - Hongik University

The Location Effect Using Embodied Horizontal Metaphor

Authors
Dr. Yoon-Na Cho - Hongik University

CUSTOMER EXPERIENCE MODEL OF MOBILE APPLICATION: IMPLICATION FOR E-TAILERS

Authors
Ms. Priya Premi - Indian Institute of Management Kozhikode
Sustainable Brand Transitions – A Case Study of alternative Proteins in the Meat Industry

Authors
Mr. Martin Berger - Institut für Marketing Universität St. Gallen

The individual and joint effects of data usage control & transparency on customers’ privacy responses

Authors
Mr. Mauro Gotsch - Institut für Marketing Universität St. Gallen

Impact of Language Style on Experience with Mr. Chatbot: Role of Automated Social Presence

Authors
Mr. Do Khoa - National Tsing Hua University

Kirana (Small Retailer) Performance and Impact of Technology Use: Evidence from the study of small retailers “Kirana stores” in northern India

Authors
Prof. Rajesh Aithal - Indian Institute of Management Lucknow
Contract Frame Portfolios and Supplier Learning

Authors
Mr. Yi Zheng - University of Texas at Arlington
Prof. Qiong Wang - University of Oklahoma
Dr. Xiaoyan Wang - Shandong University at Weihai

Cashbacks: Buying More or Less?

Authors
Ms. Shweta Jha - Indian Institute of Management, Indore, India
Prof. Sanjeev Tripathi - Indian Institute of Management, Indore, India

The Role of the Frontline Employee in Technology-Based Service Encounters

Authors
Mr. Tobias Roeding - University of Siegen
Mr. Jan-Lukas Selter - University of Siegen
Mr. Julian Schmitz - University of Siegen
Prof. Hanna Schramm-Klein - University of Siegen
Consumer perception of safety compliance amid COVID-19 pandemic: evidence from the restaurant industry

Authors
Dr. Amro Maher - Florida Gulf Coast University
Dr. Tamer Elsharnouby - Qatar University
Dr. Abdullah Aljafari - Qatar University

Determinants of Customer Engagement in Brand Communities on Instagram: An Elaboration Likelihood Model Perspective

Authors
Dr. Wan-Chu Yen - Department of Distribution Management, National Chin-Yi University of Technology

Sponsored Posts and Purchase Intention

Authors
Dr. Chien-Wei Chen - Department of International Business, National Chengchi University
Dr. Nai-Hwa Lien - Department of Business Administration, National Taiwan University
Factors Affecting Food Waste Behavior in the Collectivism Egyptian Context

Authors
Mr. Ahmed M. Adel - Huazhong University of Science and Technology
Prof. Xin Dai - Huazhong University of Science and Technology
Mrs. Rana S. Roshdy - Huazhong University of Science and Technology

Using Congruent Marketing Appeals to Promote Intergroup Helping: The Case of Fair Trade

Authors
Mr. Thomas Usslepp - Lancaster University Management School
Prof. Margaret Hogg - Lancaster University Management School
Dr. Sandra Awanis - Lancaster University Management School

Is there a smart way to manage independent sales agents in export markets? – An identification and analysis of drivers and barriers of export performance from the perspective of German small- and medium-sized manufacturing enterprises

Authors
Ms. Fabienne Ruoss - TU Dortmund
Fake News, Misinformation, and Disinformation on Social Media: Their Natures, Impacts and Treatments
[Report of Initial Findings]

Authors
Dr. Sohyoun Shin - California State University, Chico

Less Talking, More Empathy: How to use Emojis to Help People Feel Good

Authors
Ms. Farhana Nusrat - Drexel University
Prof. Yanliu Huang - Drexel University

Entitled to Be Served: Does Self-Checkout Make Customers Feel Less Rewarded?

Authors
Ms. Farhana Nusrat - Drexel University
Prof. Yanliu Huang - Drexel University
The Longitudinal Effect of Media Exposure on Fear During the COVID-19 Pandemic: An Examination of the Complex Effect of Critical Thinking

Authors
Dr. Marie-Louise Radanielina-Hita - HEC Montreal
Mr. Simon Boissonneault - HEC Montreal
Dr. Yany Gregoire - HEC Montreal
Dr. Bruno Lussier - HEC Montreal

VISUAL HIERARCHY ON E-COMMERCE SITES – DESIGN AND VISITORS’ PERCEPTIONS: INSIGHTS FROM EYE-TRACKING

Authors
Dr. Anil Mathur - Hofstra University

How Genders React Differently to Service Robots During the COVID-19 Pandemic

Authors
Dr. HyeRyeon Lee - Wilkes University
Dr. Han Ma - Wilkes University
Dr. Ge Xiao - Wilkes University

**Understanding Antecedents of Online Recommendation Agent Use – A Conceptual Framework**

**Authors**
Mr. Savisesh Malampallayil - Binghamton University School of Management

**Contactless Retail: Implications of Reshaped Shopping Journey and Roles of Stores**

**Authors**
Dr. Jiyong Hwang - The University of North Carolina at Greensboro
Dr. Laee Choi - Colorado State University-Pueblo

**Helping others helps me: The impact of disaster response on military veteran well-being**

**Authors**
Dr. Patricia Norberg - Quinnipiac University
Dr. Maxim Polonsky - Yale University

**What factors encourage information sharing on social media? The role of the self-and social-connection**

**Authors**
Dr. Miyea Kim - Barun ICT Research Center, Yonsei University
Dr. Mina Jun - Sookmyung Women's University
Dr. Jeongsoo Han - Middlesex University Dubai

The Effect of Customer Autonomy Orientation in Brand Value Co-creation

Authors
Ms. Chen Zhang - Tokyo Keizai University
Prof. Kosaku Morioka - Tokyo Keizai University

The Application of Blockchain in Digital Marketing

Authors
Dr. Sharmin Attaran - Bryant University
Dr. Mohsen Attaran - CSUB

Friends With Benefits: Strengthening Peer Effects Through Aligning Salient Reference Group Characteristics With Consumers’ Traits

Authors
Mr. Pieter Verhallen - Maastricht University
Dr. Thomas Post - Maastricht University
The YouTube Paradox of Success: How Sponsorship Opportunities Turn Social Media Influencers Into Pseudo Salespeople: Preliminary Dissertation Proposal

Authors
Mr. Louis Zmich - Louisiana Tech University

Neoteny and decision making of voters in India

Authors
Dr. Ardhendu Shekhar Singh - Symbiosis School of Banking and Finance, Symbiosis International (Deemed University), Pune
Dr. Sonal Shree - Symbiosis Institute of Business Management, Symbiosis International (Deemed University), Pune

Combined Impact of Brand-Cause Fit and Message Framing on Consumer Point-of-Sale Donation Intention: The Impact of Cause Involvement

Authors
Dr. Maumita Roy - Amity Business School
Dr. Monika Rawal - Millsaps College
Dr. Ramin Bagherzadeh - Ithaca College

Dr. Jose Saavedra - Northern Kentucky University